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Abstract

An abundance of research suggests that cellular mitochondrial and cytoskeletal disruption are 

related, but few studies have directly investigated causative connections between the two. We 

previously demonstrated that inhibiting microtubule and microfilament polymerization affects 

mitochondrial motility on the whole-cell level in fibroblasts. Since mitochondrial motility can be 

indicative of mitochondrial function, we now further characterize the effects of these cytoskeletal 

inhibitors on mitochondrial potential, morphology and respiration. We found that although they 

did not reduce mitochondrial inner membrane potential, cytoskeletal toxins induced significant 

decreases in basal mitochondrial respiration. In some cases, basal respiration was only affected 

after cells were pretreated with the calcium ionophore A23187 in order to stress mitochondrial 

function. In most cases, mitochondrial morphology remained unaffected, but extreme 

microfilament depolymerization or combined intermediate doses of microtubule and 

microfilament toxins resulted in decreased mitochondrial lengths. Interestingly, these two 

particular exposures did not affect mitochondrial respiration in cells not sensitized with A23187, 

indicating an interplay between mitochondrial morphology and respiration. In all cases, inducing 

maximal respiration diminished differences between control and experimental groups, suggesting 

that reduced basal respiration originates as a largely elective rather than pathological symptom of 

cytoskeletal impairment. However, viability experiments suggest that even this type of respiration 

decrease may be associated with cell death.
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INTRODUCTION

Cellular pathology is often assumed to be reflected by either mitochondrial or structural 

alterations, whereas in reality the two often appear in parallel. In the mitochondrial realm, 

diseased cells show changes in metabolic pathways[1,2], respiration rates [3,4], reactive 

oxygen species generation [3,5], and even mitochondrial morphology [6,7] or motility [8,9]. 

On the other hand, damaged cytoarchitecture can manifest as changes in cell shape [10], 

traction force generation [11], or stiffness of the extracellular matrix [12,13] or the cell itself 

[14,15]. While the pathways involved in both mitochondrial and mechanical dysfunction are 

individually complex, there are abundant suggestions in the literature that there are multiple 

links between them. Here we examine the mitochondrial consequences of cytostructural 

impairment. This work builds upon our previous research characterizing the effects of 

cytoskeletal toxins on mitochondrial motility in particular [16].

For decades, mitochondria have been known to be structurally linked to microtubules [17], 

and microtubule breakdown impairs mitochondrial motility [16,18]. Associations between 

mitochondria and actin filaments, which are largely responsible for cellular mechanics [19], 

have mostly been studied in yeast [20], but recent work indicates that actin is involved in 

mitochondrial motility [16] and fission [21] in mammalian cells. Beyond structure and 

motility, studies indicating functional links between mitochondria and the cytoarchitecture 

are often predicated on the observation that mitochondria tend to localize to energy-

requiring areas of the cell, such as the growth cones of neuronal axons [22] and viral 

assembly sites in infected cells [23]. Two examples include mitochondrial localization at the 

periphery of a freshly plated cell [24], which presumably locally provides energy for cell 

spreading, and the correlation of mitochondrial inner membrane potential with cellular 

projection area during early phases of cell spreading [25]. Similarly, one report 

demonstrated elevated mitochondrial inner membrane potentials in cells at the edge of a 

migrating sheet [26], and others have even shown increased mitochondrial inner membrane 

potential at the periphery of more stationary cells [27], where traction forces are usually 

highest [11]. Additional studies have demonstrated directed mitochondrial localization 

during migration of lymphocytes [28] and cancer cells [29]. While intriguing, these studies 

are limited to observations regarding subcellular localization and energetic potential of 

mitochondria, and fall short of directly examining the interplay between cytoarchitectural 

integrity and mitochondrial function.

Here, we analyzed the direct effects of cytoskeletal inhibitors on mitochondrial inner 

membrane potential, morphology, and oxygen consumption in intact, adherent human 

dermal fibroblasts. Earlier work suggests that endothelial cells rely on glycolysis, rather than 

oxidative phosphorylation, to provide ATP for actin stress fiber maintenance [30], but this is 

consistent with general glycolytic dependence of endothelial cells [31]. Our current work 

investigates whether oxidative phosphorylation may be more important for cytoskeletal 

maintenance in fibroblasts. Decreased inner membrane potential is perhaps the clearest sign 

of mitochondrial injury and thus represents an obvious first step to assessing mitochondrial 

health in response to impending damage. We also considered mitochondrial morphology 

since it is often, but not always, linked to energetic state [32]. Finally, we assessed whether 

cytoskeletal toxins induced changes in mitochondrial oxygen consumption rates, which may 
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indicate whether mitochondrial energetics are maintained or compromised. Overall, our 

work shows that while membrane potential remains intact, cytoskeletal breakdown can alter 

mitochondrial respiration by itself or in concert with known mitochondrial stressors. Our 

results further suggest that mitochondrial shortening may counteract the effects of 

cytoskeletal toxins on mitochondrial respiration.

MATERIALS AND METHODS

Cell culture and reagents

Adult human dermal fibroblasts between passages 1 and 5 (Lifeline Cell Technology, 

Walkersville, MD) were cultured in FibroLife cell culture media (Lifeline Cell Technology) 

as previously described [16]. Cells were seeded approximately 48 hours prior to 

experiments.

For experiments involving measuring changes in mitochondrial inner membrane potential 

and mitochondrial morphology, cells were plated on MatTek 35-mm glass-bottom dishes 

(MatTek, Ashland, MA) at a density of ~25,000 cells/dish. Dishes were coated for 30-40 

minutes with 10 μg/mL fibronectin (BD Biosciences, San Jose, CA) dissolved in PBS prior 

to cell plating. For oxygen consumption measurements, cells were plated in 24-well plates 

(Seahorse Biosciences, North Billerica, MA) at a density of ~10,000 cells/well. This 

concentration was determined to result in a confluent monolayer at the time of experiments. 

For cell viability experiments, cells were seeded on standard tissue-culture treated 24-well 

plates (Corning, Corning, NY) at a density of 50,000/well.

Assessing changes in mitochondrial inner membrane potential and morphology

Changes in mitochondrial inner membrane potential and morphology in single cells were 

assessed using wide-field fluorescence microscopy as previously described [16]. Cell 

viability was also measured using this setup. This system employed a QImaging QIClick 

camera (QImaging, Surrey, BC, Canada) (1x1 binning, 1392x1040 pixels) attached to an 

Olympus IX70 microscope (Olympus, Melville, NY) with an Olympus 40x oil immersion 

objective lens (Olympus) and Photofluor light source (89 North, Burlington, VT). Computer 

control of the microscope was facilitated by LUDL programmable filter wheels, shutters, 

and focus control (LUDL Electronic Products, Hawthorne, NY) and images were collected 

using IPL 3.7 software (BD, Rockville, MD). For each experiment, cells were visualized 

using standard TRITC and FITC filters.

The day before experiments, cells were transfected with CellLight Mitochondria-GFP, 

BacMam 2.0 (Life Technologies, Grand Island, NY) at a concentration of 40 particles per 

cell, and kept in the dark at 37°C. Several hours before experiments, cells were also dye-

loaded with 20 nM Tetramethylrhodamine methyl ester (TMRM, Life Technologies), a 

mitochondrial potential dye, for 60 minutes at room temperature in the dark. After rinsing, 

cells were placed in Recording HBSS (HBSS pH 7.4 with 1.3 mM CaCl2, 0.9 mM MgCl2, 2 

mM glutamine, 0.1 g/L heparin, 5.6 mM glucose, and 1% FBS) for imaging.

In each experiment, a selected cell was first imaged in both the mitoGFP and TMRM 

channels in recording HBSS. At T=0, recording HBSS was removed from the dish and 

Kandel et al. Page 3

Integr Biol (Camb). Author manuscript; available in PMC 2017 November 07.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



replaced with either recording HBSS (control), recording HBSS containing 5 μL/mL 

DMSO, or recording HBSS containing a given cytoskeletal toxin. The DMSO concentration 

was equivalent to the highest concentration of drug stock solution for which a morphology 

effect was observed, and was performed in order to ensure that no observed effects resulted 

from the DMSO solvent rather than the cytoskeletal drugs. Cytochalasin D (cytD) was taken 

from a stock solution of 1 mM in DMSO and nocodazole (noco) was taken from a stock 

solution of 10 mM in DMSO. The cell was then imaged again in both channels at T=30 

minutes. Data for each experimental group were collected over two or more days, for a total 

of 7-22 cells per group. Cytoskeletal toxins were confirmed to be working using Alexa Fluor 

546 phalloidin (Life Technologies; for cytD) and TubulinTracker (Life Technologies; for 

noco) dyes (previously shown in [16]).

Images from the mitoGFP channel were preprocessed using ImageJ as previously described 

[16]. Briefly, images were first convolved using a 5x5 edge detection filter 

(Process>Filters>Convolve). The resulting image was then bandpass filtered 

(Process>FFT>Bandpass Filter…) between 2 and 100 pixels. Finally, the image was 

manually thresholded (Image>Adjust>Threshold) by eye at a level which removed random 

background pixels in order to maximize signal and minimize noise. Before applying the 

chosen threshold value, a mitochondrial region of interest (ROI) was first generated by 

creating a selection (Edit>Selection>Create Selection) and then adding this to the ROI 

manager (Analyze>Tools>ROI Manager>Add[t]). The threshold was then applied. Figure 

1a(iv) shows the resulting image for a sample cell.

Mitochondrial inner membrane potential was measured by opening the TMRM channel 

image in ImageJ and superimposing the corresponding mitoGFP processed image ROI onto 

it (by selecting the ROI in ImageJ). Figs 1b(iv) and 1c(iv) show examples of mitochondrial 

ROIs superimposed onto corresponding TMRM images. Since the mitoGFP fluorescence 

results from transfection, it does not depend on inner membrane potential, and thus allows 

for mitochondrial identification even when mitochondria have depolarized as in the case of 

CCCP treatment. Fluorescence intensity within the mitochondrial ROI was then measured 

(Analyze>Measure) for a mean TMRM fluorescence within the mitochondrial region of the 

cell. This process was repeated for the same cell 30 minutes following drug exposure, and 

the resulting mean fluorescence was normalized to the corresponding value prior to 

treatment. 5 μM CCCP was used as a positive control (Figure 1b-c, Figure 2).

Object recognition functions in Matlab R2010a (Mathworks, Natick, MA) were applied to 

the preprocessed image of each cell at each time point (Figure 1a(iv)) in order to assess 

mitochondrial morphology. The code constructed for this purpose is publicly available 

online. Briefly, bwconncomp was used to find the mitochondrial objects in each image 

(using 8-pixel connectivity) followed by regionprops, which measured the area of each 

object. The noise floor was set at 5 pixels, and objects with areas less than this were 

discarded. The image was then reconstructed without these objects. Bwboundaries was used 

to find mitochondrial objects in the new image, and regionprops measured various attributes 

of these objects including major axis length. Since lengths were not normally distributed, the 

metric used to assess overall mitochondrial length at a given time point was the geometric 

mean. The geometric mean of mitochondrial length was then calculated for each cell 
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following treatment, and normalized to the geometric mean of the same cell prior to 

treatment. The number of mitochondrial objects detected in each reconstructed image was 

calculated using bwboundaries.

Oxygen consumption measurements

Prior to beginning respiration measurements, cells were pre-treated for 30 minutes as 

indicated with DMSO, cytD, noco or a combination thereof. Some cells were pre-treated 

prior to the addition of cytoskeletal toxins with 100 nM A23187 (A23; taken from a stock 

solution of 2 mM) for 20 minutes. This concentration was chosen based on the lack of effect 

on respiration at this concentration. After 20 minutes, A23-containing media was removed 

and replaced with media containing both A23 and appropriate cytoskeletal toxins. Control 

DMSO groups included a low DMSO concentration and a high DMSO concentration. The 

low DMSO concentration was 0.2 μL/mL (equivalent to the lowest concentration of noco or 

cytD stock used) while the high DMSO concentration was 10.05 μL/mL (equivalent to the 

highest load of DMSO from stock used, in the 50 μM noco + 5 μM cytD + A23 group). 

These controls were slightly different from those used for morphology and potential 

measurements, and were chosen to correspond to the lowest and highest DMSO 

concentrations for which an OCR effect was observed. Control cells (without DMSO) were 

maintained in their original media.

Mitochondrial oxygen consumption rates (OCR) were evaluated in intact, adherent cells 

using the Seahorse XF24 Analyzer (Seahorse Bioscience, Billerica, MD). The experiments 

were performed with unbuffered DMEM XF assay media supplemented with 2mM 

GlutaMAX, 1mM sodium pyruvate, and 5mM glucose (pH 7.4 At 37°C). The mitochondrial 

respiration was measured before any pharmacological perturbation (basal respiration). Cells 

were then subjected to 1 μg/ml oligomycin (oligo) to measure proton leak, followed by 0.4 

μM FCCP to induce maximal respiration. Finally, 1 μM rotenone followed by 1.8 μM 

antimycin A was applied in order to inhibit all mitochondrial respiration. In each 

experiment, 3 wells were left unseeded to serve as background measurements. Each 

experimental condition was applied to 4-6 wells per plate, and repeated over 3-4 days for a 

total of 12-24 wells per group.

Basal respiration was measured at three consecutive time points, as was respiration 

following application of each oligo, FCCP, rotenone and antimycin. These three values were 

averaged to give a single measure of respiration for each state for each well. Outliers were 

excluded on the basis of one or more visual criteria (1) OCR did not respond to stimulation 

with FCCP, visually showing a flat line; (2) OCR (basal, oligo, FCCP, rotenone, or 

antimycin) was visually well below background well readings; (3) Basal OCR visually lay 

well below antimycin readings for the same well. The latter two categories rarely occurred. 

More often, a fourth category was invoked, which considered wells which appeared to have 

readings significantly different from other wells in the same group from the same day. The 

OCR readings from these wells were subjected to Grubb’s test using a freely available 

online calculator (http://graphpad.com/quickcalcs/grubbs2/) to assess whether they were 

outliers, using either basal OCR or OCR following addition of a mitochondrial inhibitor. 

Significance was set at p < 0.05, and wells meeting this criterion were excluded from 
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analysis. Background readings for each plate were calculated by averaging the OCRs from 

the background wells for those plates, and subtracted from all subsequent readings. Erratic 

or extreme background well readings were excluded from this calculation. Prior to data 

analysis, the OCR from each well after antimycin addition was subtracted from the 

corresponding basal, oligo and FCCP rates in order to report only mitochondrial OCRs. 

Each well was considered to be a separate experiment, and data are presented as the mean ± 

standard deviation for all experiments.

Cell viability experiments

Two days after seeding, cells were dyed with 10 μg/mL Hoechst 33342 (Life Technologies) 

diluted in Recording HBSS for 30 minutes at room temperature protected from light. After 

rinsing, cells in each well were imaged in Recording HBSS containing 1 μg/mL propidium 

iodide (PI; Life Technologies). All drugs were dissolved in HBSS containing this 

concentration of PI. Select wells were pretreated with 100 nM A23, and were then imaged 

20 minutes following this treatment. HBSS from all wells was then replaced with HBSS 

containing applicable drugs, with the A23-pre-treated cells given drugs containing 100 nM 

A23. Cells were imaged with a 10x lens in the DAPI and TRITC channels at 30 minutes and 

3 hours following drug treatment. Exposure times were kept constant at each time point but 

sometimes were increased for later time points due to photobleaching. Each experimental 

group was tested in 2-3 wells per day, repeated over 2-3 days. Three images per well per 

time point were taken.

Data analysis and statistics

Matlab was used for pairwise t-tests comparing each experimental group to the control 

group in order to test for significance of a given experimental outcome. For oxygen 

consumption measurements, all wells from a given experimental group were compared to all 

wells from the control group (without DMSO). R was then used for adjusting p-values for 

multiple comparisons (p.adjust) using the Benjamini-Hochberg method. P-values were 

adjusted for all comparisons to a given control group. The p-values are generally accepted as 

significant when p < 0.05.

RESULTS

Mitochondrial potential is unchanged following treatment with cytoskeletal toxins

Figure 1 demonstrates how dual staining was used to measure changes in mitochondrial 

inner membrane potential. MitoGFP staining was used to create a mitochondrial ROI which 

allowed us to measure TMRM fluorescence only within the mitochondrial boundaries.

Control cells exhibited a ~30% decrease in TMRM fluorescence after 30 minutes (Figure 2). 

This decrease is probably due in part to the photosensitivity of TMRM [33], which leads to 

bleaching under the intense illumination transmitted through the oil-immersion lens. 

Additionally, replacing the medium with either control or drugged media likely leads the dye 

to redistribute between the cells and the culture dish, exiting the mitochondria and 

contributing to the observed decrease in TMRM fluorescence. This decrease likely does not 
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indicate significant mitochondrial depolarization, as CCCP addition results in a much more 

drastic decrease in TMRM signal.

Compared to control cells, none of the cytoskeletal toxins used resulted in significant 

reductions in mitochondrial inner membrane potential. In two cases (nocodazole 50 μM and 

noco 50 μM + cytD 5 μM), there was suprisingly less of a TMRM fluorescence decrease 

than in control cells (p < 0.05). This observation may indicate a slight hyperpolarization in 

comparison to normal cells, but more likely indicates that these cells randomly exhibited 

fewer effects of photosensitivity and/or dye redistribution than other cells. Alternatively, 50 

μM noco could result in a membrane potential increase reflecting a major reduction in 

cellular bioenergetics (see data from oxygen consumption measurements below). Over the 

30 minute drug exposure used in this experiment, the electron transport chain would 

continue to operate, since oxygen is not limiting. Without ADP to be rephosphorylated at the 

expense of the electrochemical gradient, the electrochemical gradient would rise accounting 

for the high membrane potential at 50 μM versus 10 μM. Overall, these data suggest that the 

cytoskeletal toxins used have no depolarizing effect on mitochondria. However, less extreme 

mitochondrial effects should not be discounted. We therefore examined the effects of these 

toxins on mitochondrial morphology and respiration.

Specific cytoskeletal toxins induce shortening of mitochondria

Analysis of mitochondrial morphology was based on mitoGFP staining. MitoGFP images 

from each time point were processed in order to generate images clearly showing 

mitochondria within the cell (Figure 1a-c(iv>)).

In most cases, mitochondrial lengths remained unchanged following treatment with 

cytoskeletal toxins (Figure 3a). However, mitochondrial lengths significantly decreased 

when cells were exposed to 5 μM cytD, or a combined dose of 10 μM noco + 1 μM cytD. 

Surprisingly, mitochondrial lengths did not change when cells were subjected to 50 μM noco 

+ 5 μM cytD. This observation suggests that mitochondrial shortening is not directly related 

to the change in cell shape induced by high concentrations of cytD.

Figure 3b shows an example of a cell subjected to 5 μM cytD exhibiting mitochondrial 

shortening. Panel (i) shows the mitoGFP channel of the cell prior to treatment, while panel 

(ii) shows the same cell after 30 minutes of exposure to 5 μM cytD. In this case, the 

geometric mean of mitochondrial lengths decreased by approximately 25% following cytD 

treatment.

We also evaluated changes in numbers of mitochondria in all experimental groups in order to 

assess whether mitochondrial shortening was indicative of fragmentation. As Figure S1 

shows, none of these groups showed alterations in mitochondrial number per cell following 

cytoskeletal inhibition that differed from control cells. This indicates that mitochondria in 

the 5 μM cytD and 10 μM noco + 1 μM cytD groups probably do not undergo fragmentation 

as a result of cytoskeletal toxicity.
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Cytoskeletal toxins caused decreased cellular basal oxygen consumption rates

Next, we measured oxygen consumption rates (OCRs) to assess whether mitochondrial 

function was perturbed in intact cells subjected to various cytoskeletal inhibitors. Figure 4a 

shows grouped experimental results from a typical trial, with outliers removed. Figure S2a 

shows the raw data from the same experiment before outliers were removed for the purposes 

of analysis, and Figure S2b shows the raw data with outliers omitted. This experiment 

clearly demonstrates that the noco 50 μM + A23 group group exhibits lower basal oxygen 

consumption rates than any of the other groups measured.

Both high and low concentrations of DMSO were confirmed to not affect mitochondrial 

respiration (Figure 4b(i)). Experimental groups were therefore compared to the controls 

(which were not treated with DMSO) for purposes of uniformity. OCR following antimycin 

addition was subtracted for each experimental well before analysis in order to only consider 

mitochondrial respiration. In many cases, exposure to cytoskeletal toxins decreased basal 

respiration, either trending towards or achieving significance (Figure 4b(ii-iv)). The most 

significant decrease was shown by the noco 50 μM + cytD 5 μM group, which showed a 

basal OCR of 34.42 ± 14.22 pmol/min as compared to the control basal OCR of 59.86 

± 23.17 pmol/min (adjusted p < 0.01). Significant (adjusted p < 0.05) OCR reductions were 

also shown by the noco 10 μM (42.26 ±14.52 pmol/min) and noco 50 μM (42.00 ± 11.19 

pmol/min) groups, with a lower (2 μM) noco exposure leading to OCR reductions which 

trended toward but did not achieve significance (45.51 ± 11.97 pmol/min). In the case of 

cytD, 200 nM (51.69 ± 19.05 pmol/min) and 1 μM (49.13 ± 15.36 pmol/min) exposures 

decreased the basal OCR without achieving significance, but 5 μM left it unchanged (60.00 

± 12.21 pmol/min). Similarly, cells treated with noco 10 μM + cytD 1 μM only slightly 

decreased the basal OCR (55.78 ± 11.86 pmol/min) without achieving statistical 

significance.

Interestingly, any differences in OCR from control cells caused by cytoskeletal toxins are 

diminished under the effects of oligo, showing that proton leak is the same across control 

and experimental groups. Similarly, FCCP blurs basal OCR distinctions between 

experimental and control groups, suggesting that maximal respiration is largely preserved 

under the influence of cytoskeletal toxicity.

Increased intracellular calcium sensitizes cells to decreases in respiration induced by 
cytoskeletal inhibitors

Based on our initial results showing OCR decreases in response to cytoskeletal toxins, we 

hypothesized that cytoskeletal toxins sensitized cells to further upsets in mitochondrial 

homeostasis. As such, we challenged the cells with 100 nM A23, a calcium ionophore, prior 

to addition of cytoskeletal toxins. A23 causes an increase in the intracellular calcium 

concentration, which is likely buffered by mitochondria and thus introduces another level of 

mitochondrial stress. The chosen concentration did not affect OCR when used alone (Figure 

5(i)).

Cells pretreated with A23 and then subjected to any concentration of noco showed 

significant decreases in basal OCR (Figure 5(ii)). Basal OCRs were 30.87 ± 12.10 pmol/min 
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for the 2 μM group (adjusted p < 0.01), 33.31 ± 9.42 pmol/min for the 10 μM group 

(adjusted p < 0.01), and 26.69 ± 14.88 pmol/min for the 50 μM group (adjusted p < 0.001). 

As in the group without A23 exposure, cells treated with A23 followed by noco 50 μM + 

cytD 5 μM showed significantly decreased OCRs of 29.28 ± 10.90 pmol/min (Figure 5(iv); 

adjusted p < 0.01). The A23 groups which differed most from their corresponding groups 

lacking A23 were cells exposed to cytD and noco 10 μM + cytD 1 μM. In the former groups, 

basal respiration is decreased in cells pretreated with A23 and then exposed to 200 nM cytD 

(37.41 ± 10.18 pmol/min; adjusted p < 0.05) or 1 μM cytD (33.24 ± 15.25 pmol/min; 

adjusted p < 0.01). Similarly, cells treated with noco 10 μM + cytD 1 μM showed decreased 

basal OCR only when pretreated with A23 (37.36 ± 14.57 pmol/min; adjusted p < 0.05). 

Cells in the 5 μM cytD group showed a slight decrease in basal respiration with A23 pre-

treatment (50.27 ± 12.80 pmol/min), but this change did not achieve significance.

OCR decreases in experimental groups somewhat carried over to maximal respiration, and 

the adjusted p-values achieved significance (p < 0.05) for noco 2 μM, noco 50 μM, cytD 200 

nM, cytD 1 μM, and noco 50 μM + cytD 5 μM (Figure 5). However, the differences between 

control and experimental groups were overall less extreme for maximal respiration than for 

basal respiration.

Cell viability was assessed in a separate group of experiments using PI staining after 

treatment. Only groups with the highest doses of drug, with and without A23, were tested 

(high DMSO ± A23, noco 50 μM ± A23, cytD 5 μM ± A23, noco 50 μM + cytD 5 μM ± 

A23). The results correlated with respiration measurements, with cells in the noco 50 μM ± 

A23 and noco 50 μM + cytD 5 μM ± A23 groups, but not the others, showing increased PI 

staining 3 hours after treatment (Figure 6). PI staining was spatially correlated with the 

appearance of floating cells in brightfield images. Importantly, PI staining did not 

appreciably increase in these groups after 30 minutes of treatment, the time around which 

basal respiration was measured.

DISCUSSION

This work establishes that cytoskeletal toxins alone can affect mitochondrial bioenergetics in 

fibroblasts. These findings differ from previous work in endothelial cells, which 

demonstrated reduced oxygen utilization in response to these toxins only when lactate 

dehydrogenase (LDH) was inhibited [30], likely connected to the glycolytic reliance of these 

cells [31]. Table 1 summarizes the results of our current work along with our previous 

findings on the effects of cytoskeletal toxins on mitochondrial motility [16]. In all cases, we 

did not see mitochondrial inner membrane depolarization within 30 minutes of treatment 

with cytoskeletal toxins, indicating that mitochondrial function is not drastically 

compromised. However, microtubule depolymerization via noco significantly reduced basal 

respiration in intact cells, an effect which was exacerbated when cells were pretreated with 

A23. This correlated with decreased mitochondrial motility in these cells [16]. CytD alone 

(200 nM and 1 μM) did not significantly affect either motility or respiration, but led to 

decreased basal OCR when cells were preconditioned with A23. The combined effects of 

actin depolymerization and increased calcium handling may thus present too great of a 

metabolic challenge for basal respiration to be maintained, although respiration maintenance 
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following 5 μM cytD + A23 suggests that effects depend on toxin concentration. The drastic 

reduction in basal OCR following severe depolymerization of both microtubules and 

microfilaments without A23 treatment (5 μM cytD + 50 μM noco) indicates an additive 

energetic consequence of these drugs. Interestingly, these cells show mitochondrial motility 

similar to controls [16], implying that changes in mitochondrial function are not necessarily 

reflected in altered mitochondrial motility.

Two particular treatment groups showed decreases in mitochondrial lengths: 5 μM cytD and 

10 μM noco + 1 μM cytD. The maintenance of basal OCR in these cells suggests a 

connection between respiration rates and mitochondrial shortening, which is discussed 

further below. The lack of shortening in the 5 μM cytD + 50 μM noco group, concurrent 

with decreased basal OCR, further supports this link. The 5 μM cytD and 10 μM noco + 1 

μM cytD groups differ in mitochondrial motility, which is increased by 5 μM cytD and 

decreased by 10 μM noco + 1 μM cytD. Additionally, A23 preconditioning does sensitize 

cells treated with 10 μM noco + 1 μM cytD, but not 5 μM cytD, to basal OCR reduction. 

Whether mitochondrial motility, which is increased by 5 μM cytD but decreased by 10 μM 

noco + 1 μM cytD, is related to this distinction is worthy of further study.

While cell death correlated with decreases in basal respiration, our results suggest that 

decreased respiration precedes cell death rather than the reverse. Little cell death was 

observed 30 minutes following treatment with noco 50 μM ± A23 or noco 50 μM + cytD 5 

μM ± A23, despite basal respiration showing significant decreases at this point (Figure 6). 

More cell death and detachment were observed at the 3 hour time point, likely resulting from 

either decreased respiration or other ramifications of cytoskeletal collapse. Decreases in 

maximal respiration, which is measured in between the 30-minute and 3-hour time points of 

PI visualization, may reflect some cell death.

We did not observe any evidence of A23 itself influencing mitochondrial function. A23 acts 

as a general calcium ionophore in cells. Increases in cytosolic calcium are generally 

followed by increases in mitochondrial calcium (e.g. [34], reviewed by [35]), which can 

stimulate dehydrogenases of the tricarboxylic acid cycle and increase ATP production at low 

levels [35]. At sustained high concentrations, however, continual calcium accumulation into 

the mitochondrial matrix can uncouple respiration [36–39] or initiate cell death via opening 

of the mitochondrial permeability transition pore [35]. We first performed experiments using 

higher A23 concentrations (2 μM) which resulted in OCR changes without the addition of 

cytoskeletal toxins, confirming that A23 alone can affect mitochondrial function. We 

lowered the A23 concentration to 100 nM, which did not alter mitochondrial respiration 

(Figure 5(i)), and seemingly stressed the mitochondria just enough to sensitize them to 

further energetic upset.

Similarly, we do not expect that the concentration of A23 used affected mitochondrial 

respiration by exacerbating the cytoskeletal effects of the drugs used. Studies showing more 

global effects of A23 caused by severe disturbances in calcium regulation [40,41], including 

actin disintegration [42] and microtubule breakdown [43], used A23 concentrations one or 

more orders of magnitude greater than our 100 nM concentration. More significantly, the 

lack of OCR change using A23 alone as well as the additive effects on basal OCR of A23 to 
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cytD and noco concentrations which alone cause extreme depolymerization [16] suggest that 

A23 does not decrease mitochondrial OCR by affecting cytoskeletal structure. Rather, it 

seems to induce a distinct and perhaps more direct stress on mitochondrial function which 

emerges when mitochondria are further stressed by cytoskeletal depolymerization.

In all experimental groups, FCCP application blurs the distinction in OCR between control 

and treated groups, suggesting that mitochondrial capacity is largely maintained. Thus, 

lowered basal respiration is likely either an elective strategy to preserve energy in response 

to cytoskeletal inhibition, or an indication that energy is no longer needed to maintain the 

cytoarchitecture through continuous turnover of actin/tubulin monomers and polymers. 

Elective OCR reductions may still be harmful to the cell and be associated with increased 

cell death, as shown by the noco 50 μM and noco 50 μM + cytD 5 μM groups (Figure 6). 

Decreased energetic requirements of cytoskeletal maintenance may underlie the basal OCR 

decreases observed in the noco 10 μM, noco 50 μM and noco 50 μM + cytD 5 μM groups. 

However, the A23 experiments suggest that decreased energetic requirements of cytoskeletal 

maintenance do not contribute in the cases of cytD (200 nM-1 μM) or noco 10 μM + cytD 1 

μM, since basal respiration is only significantly reduced when calcium regulation is altered 

by A23 in addition to cytoskeletal breakdown. Reduced maximal respiration in response to 

200 nM and 1 μM cytD in A23-pretreated cells indicates that mitochondrial capacity is 

decreased by this cocktail of treatments, but this reduction is less extreme than the decrease 

in basal OCR in these groups. Unlike cytD-treated cells, noco-treated cells show 

compromised basal OCR without A23 pre-treatment, which is further decreased when cells 

are pretreated with A23. The aggravated effect following A23 pretreatment suggests some 

element of change in mitochondrial function which is independent of the energetic 

requirements of microtubule organization. Moreover, these cells show decreased maximal 

OCRs which trend toward or achieve significance, suggesting that mitochondrial respiration 

is impaired when both calcium and microtubule maintenance are disturbed. It is likely that 

some cell death contributes to the maximal respiration decrease, which is measured 

sometime between the 30-minute and 3-hour time points when PI staining was examined. 

Again, though, the FCCP-induced decreases are less extreme than decreases in basal 

respiration, indicating a combined effect of impaired mitochondrial function/cell death and 

elective energetic conservation.

The effects of cytoskeletal inhibitors on mitochondrial morphology vary by study. De Vos et 

al. did not see mitochondrial fragmentation following cytD treatment [44], while another 

study showed extreme mitochondrial fragmentation following 50 uM cytochalasin B or 10 

uM noco in transfected epithelial cells [45]. Our observation that shortening occurs only in 

the 5 μM cytD and 10 μM noco + 1 μM cytD groups suggests that this response is highly 

specific.

The decrease in mitochondrial lengths observed in the 5 μM cytD and 10 μM noco + 1 μM 

cytD groups can either be caused by fragmentation or shortening of mitochondria. While 

numbers of mitochondria do increase following treatment (Figure S1), control cells exhibit a 

similar change. As such, mitochondria in treated cells do not appear to fragment to a greater 

degree than those in control cells. We do not expect that defective mitochondria resulting 

from fragmentation are lysed in the 30 minute duration of the experiment, so the numbers of 
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mitochondria detected at 30 minutes should be a true reflection of the effects of cytoskeletal 

inhibitors on mitochondrial number. We therefore conclude that the length decrease 

exhibited by mitochondria in these treatment groups is likely indicative of shortening rather 

than fragmentation. Most discussion in the literature pertaining to decreases in 

mitochondrial length relates to mitochondrial fission rather than shortening, with many 

studies observing mitochondrial fragmentation when mitochondrial energetics are severely 

impaired [46] and as a sign of apoptosis [47,48]. However, more recent work suggests that 

mitochondrial fragmentation may actually benefit the cell as a mechanism of eliminating 

dysfunctional mitochondria [49]. Several studies relate mitochondrial shortening without 

concurrent proportional increases in number of mitochondria. Examples include fibroblasts 

of patients with complex I deficiency [50] or neurons subjected to complex I inhibitors [51]. 

This phenomenon is overall less studied than mitochondrial fragmentation, and may 

represent an entirely different effect [51].

The two-dimensional imaging used for these experiments precluded definitive assessments 

as to whether mitochondrial shortening was indicative of changes in cell volume. However, 

multiplying normalized mitochondrial area by normalized number of mitochondria in a 

given cell should provide a two-dimensional estimate of change in mitochondrial “area” per 

cell. Beyond two-dimensionality, this strategy is additionally limited in its predictive ability 

because mitochondria were artificially “thickened” during image processing. Nonetheless, 

we found that cells in the control, 10 μM noco + 1 μM cytD and 5 μM cytD groups showed 

total mitochondrial areas of 122 ±25%, 92 ± 16% and 81 ± 14%, respectively, compared to 

before treatment. The latter two groups had the smallest metrics of total mitochondrial area 

among all groups tested, although two other groups had metric in the same range, likely 

resulting from the combined effects of smaller decreases in mitochondrial number and area 

compared to controls. While not providing definitive evidence of loss of mitochondrial 

volume, these preliminary results suggest that mitochondrial shortening observed in the 10 

μM noco + 1 μM cytD and 5 μM cytD groups might be accompanied by decreased 

mitochondrial volume although not fragmentation per se.

In the present study, the concurrent observation of mitochondrial shortening with preserved 

basal OCR may have one of several mechanistic indications. As a cause, mitochondrial 

shortening may represent a protective mechanism that works to prevent cells from reducing 

respiration rates following severe cytoskeletal impairment. Alternatively, mitochondrial 

shortening may be an adverse effect of failure to decrease OCR in the face of severe 

cytoskeletal breakdown. In either case, the reduction of basal OCR in cells preconditioned 

with A23 and then treated with 10 μM noco + 1 μM cytD suggests that cells exposed to this 

cocktail of cytoskeletal toxins cannot maintain normal respiration rates when their 

mitochondria are already stressed by increased demands of calcium maintenance. The 

combination of A23 and 5 μM cytD, on the other hand, does not result in a reduction of 

basal OCR, suggesting that calcium-induced stress does not add to the effects of severe 

disintegration of actin alone. In either case, the interaction between mitochondrial shortening 

and respiration in these two groups seems to represent an entirely different energetic 

mechanism than reductions in basal OCR shown in other treatment groups, and merits 

further mechanistic study.

Kandel et al. Page 12

Integr Biol (Camb). Author manuscript; available in PMC 2017 November 07.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



CONCLUSION

This study overall demonstrates that cytoskeletal impairment directly affects mitochondrial 

function in fibroblasts. Microtubule disintegration leads to decreased basal respiration which 

is exacerbated when mitochondria are additionally stressed with elevated calcium levels. On 

the other hand, actin depolymerization only affects mitochondrial respiration under 

conditions of disturbed calcium homeostasis. Mitochondrial shortening occurs in specific 

cases when respiration rates remain unchanged, suggesting an interplay between 

mitochondrial morphology and respiration. A systematic study of the interplay between 

cytoskeletal depolymerization and calcium homeostasis as affected by low A23 

concentrations may elucidate the mechanisms underlying these findings. Additional 

experiments using inhibitors of mitochondrial fission may also confirm the potential 

protective effects of mitochondrial shortening on energetic maintenance in the cell, despite a 

majority of studies associating mitochondrial fragmentation with dysfunction. If the 

mitochondrial shortening we observe is operating by the same mechanisms as mitochondrial 

fission, then inhibiting fission may cause reduced basal OCR in cases when shortening 

appears to be protective.

Investigating the direct effects of cytoskeletal breakdown on mitochondrial respiration in 

fibroblasts demonstrates that cytoskeletal toxicity at times directly leads to reduced 

mitochondrial oxygen consumption in these cells, but more pervasively sensitizes them to 

further energetic insult. Beyond indicating a functional connection between mitochondria 

and the cytoskeleton, this work suggests that cells with distorted cytostructures lead to 

changes in cellular metabolism which may contribute to altered or compromised function. 

Relevant examples include migrating or dividing cells, which show temporary changes in 

their cytoarchitecture, as well as cancer cells or cells from patients exhibiting cardiovascular 

disease, which show permanent mechanical changes.
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While mitochondria are known to be physically linked to microtubules, functional 

connections between mitochondria and the cytoskeleton are largely unexplored. We 

previously demonstrated that cytoskeletal toxicity alters mitochondrial motility in human 

fibroblasts. Here, we further characterize the mitochondrial effects of cytoarchitectural 

breakdown through quantitative approaches to fluorescence microscopy and metabolic 

assays. We show that cytoskeletal toxins can lead to decreases in mitochondrial oxygen 

consumption, and that intracellular calcium increases further sensitize mitochondria to 

this effect. Our results additionally suggest that decreased mitochondrial lengths correlate 

with maintenance of mitochondrial respiration. Underscoring causative connections 

between mitochondrial and cytoskeletal alterations may inform mechanisms underlying 

development of many diseases, such as cancer and cardiovascular disease, which feature 

dysfunction in both of these realms.

Kandel et al. Page 17

Integr Biol (Camb). Author manuscript; available in PMC 2017 November 07.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



Figure 1. Measuring changes in mitochondrial morphology and inner membrane potential using 
fluorescence microscopy
Image of a sample cell co-stained with CellLight Mitochondria-GFP (mitoGFP) and 

TMRM. In all rows, (i) shows mitoGFP, (ii) shows TMRM and (iii) shows the two channels 

merged. (a) image of the entire cell before any drug treatment. (iv) shows the image 

resulting from ImageJ processing of the mitoGFP image in order to measure mitochondrial 

morphology and create a ROI for measuring mitochondrial inner membrane potential. The 

red dotted box indicates the area of the cell depicted in panels (b-c).(b-c) Magnified section 

of the cell prior to (b) and following (c) treatment with 5 μM CCCP. (iv) shows how the ROI 

resulting from the mitoGFP channel is overlaid onto the TMRM channel in order to measure 

TMRM fluorescence only within the mitochondria.
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Figure 2. Mitochondrial potential remains unchanged following treatment with cytoskeletal 
toxins
Before drug treatment, cells were imaged in both the mitoGFP and TMRM channels. The 

mitoGFP channel was used to create a mitochondrial ROI which was then overlaid onto the 

TMRM image in order to measure fluorescence only within the mitochondria. The same 

procedure was repeated at 30 minutes following drug treatment, and resulting TMRM 

fluorescence for each was normalized to fluorescence for that cell prior to treatment. N=7-22 

cells per group, each from a separate dish. * indicates an adjusted p-value of < 0.05, *** 

indicates adjusted p < 0.001 resulting from pairwise t-tests.
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Figure 3. Specific cytoskeletal toxins induce shortening of mitochondria
(a) ImageJ was used to preprocess the mitoGFP image for each cell at each experimental 

time point. Matlab object recognition functions then measured physical characteristics of the 

mitochondria in the resulting image. Geometric means of mitochondrial lengths were 

calculated for each cell at each time point. Geometric mean length of mitochondria in a 

given cell at T=30 was then normalized to geometric mean length at T=0 for the same cell. 

N=8-22 cells per group. * indicates an adjusted p-value of < 0.05, *** indicates adjusted p 

<0.001 resulting from pairwise t-tests. (b) An example cell exhibiting mitochondrial 

shortening. (i) shows the cell prior to treatment, and (ii) shows the same cell at 30 minutes 

following treatment with 5 μM cytD. Red dotted lines indicate subcellular areas shown in the 

insets.
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Figure 4. Influence of cytoskeletal inihibitors on basal oxygen consumption
(a) Sample oxygen consumption experiment. Each tracing represents the mean OCR 

readings from all wells in a given group (N=4-6 wells per group in a single experiment). 

Error bars show standard deviations for each group. Outliers have been omitted. Two of the 

three background wells in this case were outliers, so the background reading has no standard 

deviation. (b) Oxygen consumption rates for (i) control groups; (ii) groups treated with noco; 

(iii) groups treated with cytD; (iv) groups treated with both noco and cytD. The OCR from 

each well following antimycin addition has been subtracted prior to data analysis in order to 

consider only mitochondrial respiration. Bars represent means with error bars showing 

standard deviations. N=11-17 wells per group. *indicates p < 0.05; ** indicates p < 0.01.
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Figure 5. Cytoskeletal inhibitors sensitize cells to changes in calcium homeostasis, leading to 
decreased basal mitochondrial oxygen consumption rates
Oxygen consumption rates for cells treated with (i) A23 alone; (ii) noco and A23; (iii) cytD 

and A23; (iv) noco, cytD and A23. The OCR from each well following antimycin addition 

has been subtracted prior to data analysis in order to consider only mitochondrial respiration. 

Bars represent means with error bars showing standard deviations. N=12-17 wells per group. 

*indicates p < 0.05; ** indicates p < 0.01; *** indicates p < 0.001.
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Figure 6. Viability of cells following highest doses of drug treatments
Cell nuclei are stained in blue with Hoechst, while red dye indicates PI staining. 

Representative images shown were taken at the same exposure at each time point and 

identically contrast enhanced for better visualization across all time points. Green arrows 

indicate rounded cells in both fluorescent and phase images.
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Table 1

Summary of mitochondrial effects of cytoskeletal toxins

Group Motility
[16]

Length OCR OCR with A23

CytD 200 nM -- -- -- ↓ *

CytD 1 μM -- -- -- ↓ **

CytD 5 μM ↑ ↓ * -- --

Noco 2 μM ↓ -- -- ↓ **

Noco 10 μM ↓ -- ↓ * ↓ **

Noco 50 μM ↓ -- ↓ * ↓ **

CytD 1 μM + Noco 10 μM ↓ # ↓ *** -- ↓ *

CytD 5 μM + Noco 50 μM -- -- ↓ ** ↓ **

Results detailing our previous work on mitochondrial motility are shown in the “Motility” column. ↑ indicates an increase as compared to control, 
while ↓ indicates a decrease as compared to control.

*
indicates adjusted p < 0.05,

**
p < 0.01,

***
p < 0.001.

#
indicates work which was previously performed but not published together with our earlier work on mitochondrial motility.
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